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Настройка шлюзов безопасности CSP VPN Gate и CSP RVPN производится 
одинаково, выполняют они одни и те же функции, поэтому в дальнейшем 
будем использовать только одно наименование – шлюз безопасности CSP 
VPN Gate или Продукт CSP VPN Gate, или Продукт. 

 

Cisco Security Manager 3.2 (CSM), который входит в состав Cisco Security 
Management Suite, используется для централизованного удаленного 
управления шлюзами безопасности CSP VPN Gate.  

В данном документе описывается совместимость CSM с шлюзами CSP VPN 
Gate версии 3.0. В предыдущих версиях CSP VPN Gate совместимость с CSM 
отсутствует. 

Другой компонент Cisco Security Management Suite – Cisco MARS в данном 
документе не рассматривается. 

 

 

Добавление шлюза в CSM 
 

Для работы с CSM предварительно должен быть установлен Cisco Security 
Manager Client. 

Для коммуникации CSP VPN Gate с CSM используется протокол SSH.  

CSM допускает использование протокола SSH версии 1 и 2, но рекомендуется 
использовать протокол SSH версии 2. 

Протокол SSL, используемый в CSM по умолчанию, не поддерживается. 

Для переключения CSM на протокол SSH нужно выполнить: 

 выбрать в меню Tools -> Security Manager Administration 

 далее выбрать вкладку Device Communication 

 в параметре Transport Protocol (IOS Router) выбрать SSH 

 сохранить изменения Save и закрыть окно Close 

Поддерживается добавление устройства по сценарию ”Add Device From 
Network” (File -> New Device -> Add Device From Network). 

Поддерживается получение текущей конфигурации с работающего устройства, 
уже добавленного в CSM (Policy -> Discover Policies on Device). 

В CSM шлюз безопасности идентифицируется аналогично устройству Cisco 
Router 2811 с установленной операционной системой IOS v.12.4(13a). 

 

 

В данном документе описаны основные шаги, которые следует выполнить для 
создания политики безопасности, а также особенности и ограничения, которые 
в данный момент существуют при настройке CSP VPN Gate. 

Рассмотрим основные разделы графического интерфейса CSM, 
поддерживаемые в данной версии CSP VPN Gate. 
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Настройка пакетной фильтрации 
 

В разделе Firewall поддерживается только настройка пакетной фильтрации 
– подраздел Access Rules.  

В подразделе Access Rules поддерживается блокирование/разрешение 
прохождения пакетов по следующим признакам: 

 Source, Destination, Subnet 

 весь IP-трафик или конкретные предустановленные протоколы 

 для UDP и TCP протоколов допускается задание отдельных портов и 
диапазонов портов. 

При создании правил пакетной фильтрации следует использовать 
рекомендуемые настройки и учитывать некоторые ограничения: 

 не поддерживается перечисление портов и диапазонов портов 

 не допускается фильтрация по отдельным типам ICMP сообщений, 
только протокол ICMP целиком 

 перечисление в одном правиле нескольких сервисов (поле Services), 
принадлежащих UDP или TCP протоколу приведет к ошибке (например, 
HTTP и HTTPS, SNMP и SNMP-TRAP). Рекомендуется создавать 
отдельные правила для каждого из протоколов.  
Сочетание сервисов, основанных на разных протоколах (например, 
HTTP, IPSec-ESP, SNMP) допустимо, но рекомендуется вообще 
отказаться от перечисления нескольких сервисов в одном правиле; 

 при создании или редактировании своего сервиса следует соблюдать 
следующие ограничения: 

 не следует задавать типы ICMP сообщений 

 для UDP и TCP протоколов: 

 допускается задать единичный номера порта 

 допускается задать один диапазон портов 

 допускается слово any для обозначения всего диапазона портов 

 не допускается перечисление портов и диапазонов портов 

 не допускаются модификаторы lt, gt, neq. Модификатор eq 
допускается, но его писать не обязательно. 

 при добавлении и редактировании Access Rule не следует менять 
следующие настройки Advanced: 

 Traffic Direction допускается только “In” (значение по умолчанию: для 
исходящего трафика будут работать неявные правила, 
симметричные правилам для входящего трафика); 

 не поддерживаются никакие дополнительные опции: Enable Logging 
(IOS), Options (IOS) – Fragment и Established и т.п. 
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Настройка Site to Site VPN 
 

В разделе Site to Site VPN поддерживаются следующие топологии: 

 “звезда” (Hub and Spoke VPN) 

 “точка-точка” (Point to Point VPN) 

 “каждый с каждым” (Full Mesh VPN). 

В топологии Hub and Spoke VPN не поддерживается вариант конфигурации 
с резервированием шлюза. 

В IPSec Technology допускается только Regular IPSec (GRE не 
поддерживается). 

Существуют некоторые ограничения в подразделах раздела Site to Site 
VPN. Чтобы увидеть эти подразделы надо нажать кнопку Edit VPN Policies. 

Подраздел IKE Proposal 

 IKE Proposal допускается задавать с использованием Authentication 
Certificate или Preshared Key; 

 чтобы использовать алгоритмы ГОСТ Р 34.11.94 и ГОСТ 28147-89 
следует указать следующие алгоритмы: Hash – MD5, Encryption – 
DES. 

Подраздел IPSec Proposal 

 для использования алгоритмов ГОСТ в IPSec Transform Sets 
следует использовать следующие алгоритмы: ESP Hash и AH Hash 
– MD5, ESP Encryption – DES 

 не поддерживается компрессия, поэтому флажок Compression 
должен быть снят 

 не поддерживается Reverse Route. 

Подраздел Public Key Infrastructure 

 при использовании Authentication Certificate требуется ввод CA-
сертификата в разделе PKI Enrollment/CA Information -(Enter 
Manually) 
Получение СА сертификата по SCEP протоколу не поддерживается 

 не поддерживается enrollment, поэтому любые введенные значения 
будут игнорироваться. Однако, их следует заполнить, чтобы не 
спровоцировать ошибку в CSM 

 при использовании Authentication Certificate допускаются варианты 
Revocation Check Support: Checking Not Performed, CRL Check 
Required, CRL Check Attempted. 
OSCP Check не поддерживается. 

Подраздел VPN Global Settings 

Подраздел ISAKMP Settings / IPSec Settings 

В ISAKMP Settings допускается: 

 устанавливать/сбрасывать флаг Enable Keepalive и 
настраивать параметры Interval и Retry, флаг Periodic (Router 
except 7600) устанавливать не рекомендуется 

 настраивать Identity 

 настройки остальных параметров менять не следует. 

В IPSec Settings допускается: 

 устанавливать/сбрасывать флаг Enable Lifetime и настраивать 
параметры Lifetime sec. и Lifetime Kbytes 
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 настройки остальных параметров менять не следует. 

Подраздел NAT Settings не поддерживается 

Подраздел General Settings/ Fragmentation Settings 

 допускается настройка DF Bit 

 независимо от установки флага Enable Fragmentation before 
Encryption драйвером VPN будет самостоятельно принято 
решение фрагментировать пакет или нет, и такая фрагментация 
осуществляется только после IPsec инкапсуляции. Команды в 
конфигурации, порождаемые CSM установкой или отсутствием 
указанного флага, будут проигнорированы 

 остальные настройки данной вкладки не следует менять. 
 

 

Настройка Interfaces 
 

В разделе Interfaces можно посмотреть настройки всех Cisco-интерфейсов.  

В CSM интерфейсы разделены по ролям. Например, по умолчанию есть 
деление на Internal и External интерфейсы. Чтобы изменить данную 
настройку надо: 

 нажать правую кнопку мыши на устройстве, выбрать Device 
Properties… 

 Policy Object Overrides -> Interface Roles. 

 

 

Настройка Platform 
 

Существуют некоторые ограничения в подразделах раздела Platform. 

Подраздел Device Admin – поддерживаются следующие подразделы: 

Accounts and Credentials 

Device Access 

Hostname 

Подраздел Accounts and Credentials 

 не допускается выставление флага Enable Password 
Encryption Service 

Подраздел Device Access / SNMP 

 в подразделе Permissions следует соблюдать следующие 
ограничения: 

 нельзя создавать больше одной записи; 

 не допускается тип записи Read-Write, только Read-Only 

 не допускается привязка Access Control Lists 

 в подразделе Trap Receiver следует соблюдать следующие 
ограничения: 

 не следует пользоваться кнопкой Configure Traps… 
Если необходимо отсылать SNMP traps, следует в 
cs_console, не используя CSM, задать команду snmp-
server enable traps 
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 при добавлении или редактировании Trap Receiver 
нельзя задавать SNMP Version 3. Допускаются только 1 
или 2c. 

 

Подраздел Logging 

Подраздел Logging Setup 

 допускается включать/отключать флаг Enable Logging. 
Отключение флага вызывает полное отключение логирования 

 допускается настраивать Trap / Trap Level 

 остальные настройки: Logging Buffer, Rate Limit, Origin Id не 
поддерживаются. 

Подраздел Syslog Servers 

 нельзя создавать больше одной записи 

 не допускается выставление флага Forward Messages in XML 
Format. 

 

Подраздел Routing – поддерживается только Static Routing: 

Подраздел  Static Routing 

 не допускается выставлять флаг Permanent route 

 не рекомендуется задавать Distance Metric. 
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Особенности при работе с конфигурацией 
 

1. Рекомендуется не использовать сценарии, в которых настройка CSP VPN 
Gate выполняется как через CSM, так и вручную. Если потребность в 
таком сценарии существует, то надо стараться задавать вручную только 
те команды, которые CSM не использует в процессе настраивания CSP 
VPN Gate. 

Следует учитывать, что при отгрузке конфигурации, CSM может изменить 
или удалить некоторые из команд, которые существовали в изначально 

импортированной конфигурации, например ip local pool или crypto 

isakmp policy. 

Для примера рассмотрим, почему создание политики безопасности шлюза 
через CSM для работы с мобильными клиентами невозможно. 

Порядок действий, который приводит к данному ограничению, следующий: 

 шлюз добавлен в CSM для работы по одной из топологий 

 при помощи CSM проведена централизованная настройка шлюзов 
по одной из топологий - FullMesh, Hub and Spoke, Point to Point 

 затем, например, по SSH отредактировать конфигурацию одного из 
шлюзов для работы с мобильными клиентами – создать пул 
адресов, привязать к криптокарте, создать identity и др. 

 после загрузки на шлюз созданной конфигурации через CSM, 
работа с мобильными клиентами будет невозможна в созданной 
топологии. 

Причина состоит в том, что все пулы адресов, не привязанные к команде 

crypto isakmp client configuration address-pool local, CSM 

удаляет. 

 

2. Возможны некоторые проблемы с восстановлением конфигурации. В 
некоторых случаях изменение или удаление существующих команд может 
быть безвозвратным: даже если в CSM удалить изменения, внесенные в 
конфигурацию, например, удалить VPN Topology, первоначальная 
конфигурация (которая была до Deploy) может не восстановиться в 
полном объеме. Более того, возможны ситуации, когда какие-то элементы 
конфигурации могут быть испорчены именно при отмене изменений, 
сделанных в CSM. Например: 

 в первоначальной конфигурации была настройка crypto isakmp 
identity dn 

 в CSM, в VPN Global Setings выставлена настройка Identity – 
Distinguished Name 

 в прогружаемой из CSM конфигурации команда crypto isakmp 

identity отсутствует 

 если потом удалить VPN Topology и снова прогрузить 

конфигурацию, то будет прописана команда crypto isakmp 

identity address (значение по умолчанию), что отличается от 

того, что было в первоначальной конфигурации. 

 

3. CSP VPN Gate не поддерживает функциональность Rollback, 
позволяющую вернуться к конфигурациям, которые были загружены в 
устройство ранее (Tools / Configuration Archive…). 
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Пример создания политики безопасности 
 

Сценарий 

Две подсети защищаются шлюзами безопасности CSP VPN Gate 3.0. Трафик 
между шлюзами безопасности защищен туннелем. Аутентификация сторон 
осуществляется на предустановленных ключах. 

 

Запуск Cisco Security Manager 

При запуске указываем имя сервера (ip адрес), на котором установлен Cisco 
Security Manager, логин и пароль пользователя. 

 

Подключение CSP VPN Gate к CSM 

Подключение CSP VPN Gate к CSM производится через добавление нового 
устройства File -> New Device: 

 выбрать предложение Add Device From Network 

 в разделе Identity ввести IP Type. IP Address, Display Name (если 
необходимо), OS Type.  

Вводим IP Type – Static, IP-Address – 10.0.34.11, OS Type – IOS 

В разделе Discover Device Settings оставляем настройки 
предлагаемые по умолчанию. 

 в разделе Primary Credentials ввести Username, Password 
(пользовательский пароль) и Confirm. Если пользователь 
непривилегированный, необходимо еще ввести Enable Password и 
Confirm. 

Например, вводим Username – cscons, Password – csp, Confirm – 
csp. 

В разделе HTTP Credentials оставим рекомендуемые настройки: 

HTTP Port – 80, HTTPS Port – 443, Mode – HTTPS. 

Нажимаем кнопку Finish 

 

 
Подключим второй CSP VPN Gate с IP-адресом 10.0.34.12. 

 

Описание топологии сети 

 

В разделе Site to Site VPN выберем топологию создаваемой защищенной сети 
Point to Point VPN. 

IPSec Technology – укажем Regular IPSec (Рисунок 1) 
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Рисунок 1 

 
Выберем устройства, между которыми будет создаваться защищенное 
соединение: CSP VPN Gate с адресом внешнего интерфейса 10.0.34.11 и CSP 
VPN Gate с адресом внешнего интерфейса 10.0.34.12 (Рисунок 2). 

 

Рисунок 2 
 



Управление CSP VPN Gate с помощью CSM 

CSP VPN Gate Copyright © S-Terra CSP 2003 -2009     11 

Затем для каждого устройства можно отредактировать такие параметры 
соединения как VPN Interface и Protected Networks: 

 для VPN Interface укажем FastEthernet0/0, установим переключатель 
Peer IP Address в положение VPN Interface IP Address 

 для Protected Networks укажем FastEthernet0/1. 

Установленные параметры отображает Рисунок 3. 

 

Рисунок 3 
 

Нажмем кнопку Finish. Созданная VPN появится в окне Cisco Security Manager 
в разделе Devices (Рисунок 4). 
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Рисунок 4 

 
Нажав кнопку Edit VPN Policies, перейдем в новое всплывающее окно Site-To-
Site VPN Manager (Рисунок 5) в раздел VPNs, где настроим следующие 
параметры: 

 IKE Proposal 

 IPSec Proposal 

 Preshared Key 

 VPN Global Settings 

Если бы у нас была аутентификация на сертификатах, то понадобились бы 
настройки Public Key Infrastructure. 
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Рисунок 5 

 

Настройка IKE политики 

 
Настроим параметры IKE политики: зададим приоритет, создаваемой 
политики; выберем алгоритмы шифрования и аутентификации; метод 
аутентификации; выберем группу Diffie-Hellman; установим время жизни SA. 
(Рисунок 6) 

 Устанавливаем Priority - 10 

 Из списка Encryption Algorithm выбираем значение des, которое будет 
интерпретироваться CSP VPN Gate как алгоритм шифрования ГОСТ 
28147-89. 

 Из списка Hash Algorithm выбираем значение MD5, которое будет 
интерпретироваться CSP VPN Gate как алгоритм хеширования ГОСТ Р 
34.11-94. 

 Указываем Modulus Group – 2 (Diffie-Hellman Group 2) 

 Задаем значение Lifetime – 3600 сек. 

 Из списка Authentication Method выбираем Preshared Key 
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Рисунок 6 

 

 
 

Настройка IPSec политики 

 

Настроим параметры IPSec политики: 

Создадим Transform Set (Рисунок 7) 

 

 

Рисунок 7 
 

 Установим туннельный режим  - из списка значений Mode выберем – 
tunnel 
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 Из списка ESP Encryption выберем алгоритм шифрования des, это 
значение будет интерпретироваться CSP VPN Gate как алгоритм 
шифрования ГОСТ 28147-89. 

 Из списка ESP Hash Algorithm выбираем значение md5, которое будет 
интерпретироваться CSP VPN Gate как алгоритм хеширования ГОСТ Р 
34.11-94. 

Настроим остальные параметры (Рисунок 8): 

 Установим переключатель Crypto Map Type в положение Static 

 Установим флаг Enable Perfect Forward Secrecy. Выберем Modulus 
Group – 2. 

 Lifetime – 3600 сек. 

 Lifetime – 4608000 kbytes 

 

 

Рисунок 8 
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Preshared Key 

 

Зададим автоматическую генерацию предопределенных ключей. 

Выберем метод согласования Main Mode Address. Установим Main Mode 
Address Type – Peer Address. (Рисунок 9) 

 

 

Рисунок 9 
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VPN Global Settings 

 

Установим глобальные параметры VPN в подразделе ISAKMP/IPSec Settings 
(Рисунок 10) 

 ISAKMP Settings 

Установим флаг Enable Keepalive 

Значения Keepalive – Interval и Retry принимаем по умолчанию 

Для Identity выбираем значение Address 

 IPSec Settings 

Установим флаг Enable Lifetime 

Значение Lifetime принимаем по умолчанию – 3600 секунд и 
4608000 кбайт 

 

 

Рисунок 10 
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В подразделе General Settings (Рисунок 11) 

 Fragmentation Settings 

Выбираем для Fragmentation Mode (IOS) значение No Fragmentation 

Для DF Bit выбираем значение Copy 

 

 Устанавливаем флаг Enable Split Tunneling 

 

 

Рисунок 11 
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VPN Summary 

 

Посмотреть основные установленные VPN параметры для CSP VPN Gate 
можно в разделе VPN Summary (Рисунок 12) 

 

 

Рисунок 12 
 

Более подробно посмотреть созданную конфигурацию можно по команде меню 
Tools -> Preview Configuration. 
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Доставка конфигурации на устройство 

В меню Tools выбираем Deployment Manager 

 

Рисунок 13 

 
В появившемся окне (Рисунок 13) нажимаем кнопку Deploy. Будет предложено 
выбрать устройства, на которые будет доставляться конфигурация (Рисунок 
14). CSM автоматически определяет устройства, для которых были сделаны 
изменения, но конфигурация на которые не была загружена. 

 

Рисунок 14 
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По кнопке Deploy, будет выполнена попытка загрузить конфигурацию на 
устройство. Если конфигурация будет доставлена на устройство успешно, то 
выдается соответствующее сообщение (Рисунок 15), в случае неудачи – будет 
выдано сообщение об ошибке. 

 

Рисунок 15 


